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1.0 Purpose 

This document contains procedures for developing a project workplan using the Workplan 
Template WMT 210 blank workplan template.mpt, maintaining the workplan following plan 
approval and tracking and reporting work progress as the project progresses. 

2.0 Related Documents 

A companion document, Workplan Management Standards and Guidelines, should be used in 
conjunction with this document. 

3.0 Adjustments to the Standard Settings for MS Project 

The PSO recommends the following changes be made to the “out of the box” MS Project. The 
standard template assumes these changes have been made. 

1. Go to Tools/Options. 

2. In “View” tab change Date format to “Jan 31 ‘00” to eliminate the days of the week. 

3. In “Edit” tab for time in Project1: 
• Change Minutes to “m”. 
• Change Hours to “h”. 
• Change Days to “d”. 
• Change Weeks to “w”. 
• Change Years to “y”. 
• Untick “Add space before field.” 
• Click on “Set as Default” button. (Don’t forget this!) 

4. In “Schedule” tab: 
• Both Duration and Work should be set as “Days”. 
• (Optional) Set Default Task Type to “Fixed Duration”. 
• Click on “Set as Default” button. 

5. In “Calendar” tab, do not change settings from standard. By using days for both duration 
and work, we avoid worrying about how many hours in a typical day. 

6. If using PSO standard format for Resource Initials, where John Smith is “Jsmi”, go to 
Tools/Autocorrect and untick “Correct Two Capitals.” 

7. If you are not using the PSO template then you should change the calendar to eliminate 
statutory holidays. The standard template has already taken care of this. 

4.0 Procedures 

 Step Action 
1  Start  Open Workplan Template.  

 1.1 Download template.mpp. Select "Open It" or "Save it to Disk".  

2  Save Filename  SAVE AS your project file name.  

 2.1  Save file as (Your drive):\(folder)\(planname).mpp. This should be the 
j t k l h h i di t f ld
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 Step Action 
project workplan name you have chosen, in your directory or folder on 
your PC.  

3  Project Info  Set up project summary information.  

 3.1  Ensure that your project is in the current window.  

 3.2  Go to FILE/PROPERTIES/Summary Tab.  

 3.3  Enter:  
Title: Project Name (capitalize) 
Subject: Subproject Name (or alternative, if needed) 
Manager: Sponsor and Manager/Leader (or alternative) 
Company: Organization/Branch Name (or alternative) 
These four fields automatically transfer to the headings of the standard 
reports. You may fill in any other fields that you wish. They are not used 
anywhere else.  

 3.4  Click OK.  

 3.5  Go to PROJECT/PROJECT INFORMATION.  

 3.6  Enter the Start Date for the project.  

 3.7  Click OK.  

4  Task Names  Enter task names, milestones and deliverables.  

 4.1  Ensure that you are in VIEW/ENTRY GANTT TASKS or VIEW/TASK 
SHEET.  

 4.2  Check Table (VIEW/TABLE). Use Entry (Data), Details or Tasks.  

 4.3  You may adjust column widths by placing the mouse cursor on the 
column borders in the title line and moving right or left. If printing, make 
sure it will fit on one page left to right.  

 4.4  Enter all Task Names.  

Task 0 or 1 should be the main Project Name, and should be the only 
task at this level of the workplan. (Task "0" comes up automatically if 
you checked the "Outline Options" for "Project Summary Task" in 
TOOLS/OPTIONS/VIEW.  

Use indentations (arrows on left of task bar) to move between levels in 
order to create sections with summary and detail tasks.  

Do Not enter duration, linkages or any other field values at this point. All 
tasks will show 1 day duration, starting at the project start date at this 
point.  

 4.5  A milestone, with a duration of 0 days, should be entered as the final 
detail task for every summary task. Milestones will automatically appear 
in italics, and will be displayed on the Gantt chart using the diamond 
symbol.  

 4.6  To designate a milestone as a major milestone, use the Entry (Flags) 
Table (VIEW/TABLE/Entry (Flags)) and mark Major Milestones as "Yes".  

 4.7  All project deliverables should appear in the workplan. Enter 
deliverables and set duration to 0-days and enter "yes" in the 
Deliverables column of the Entry (flags) Table. Deliverables will 
automatically appear in italics, and will be displayed on the Gantt chart 
using the box symbol.  

 4.8  Check to ensure that detail task names, summaries, milestones, major 
milestones and deliverables are all correct and located on the 
appropriate level of the workplan.  
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 Step Action 
 4.9  Save file.  

5  Linkages  Enter linkages.  

 5.1  Enter all Linkages. There are at least four options for doing this:  

Select a task. Enter the task numbers for all predecessor tasks in the 
Predecessor column, and the task numbers for all successors in the 
Successor column (you may have to shorten the Task Name column in 
order to view these columns, alternatively, you may use the Linkages 
table). Make sure you press Enter after each entry. Warning: Using the 
Mouse button can result in extraneous entries.  

Go to WINDOW/SPLIT and create a split window. The window at the 
bottom is another version of the Task Entry screen, known as the Task 
Form. Select a task. At the bottom right, enter all the Predecessor IDs. If 
type is other than Finish-to-Start, enter the Type (SS, SF, FF). If Lag is 
other than 0 days, enter Lag (or Lead as a negative number). To delete 
a linkage, highlight the linkage ID and click Delete key. When done with 
this task, click OK.  

Use Link and Unlink keys on the Task Bar to create or delete linkages. 
Hold Ctrl key to choose non-adjacent tasks. NOTE: this method only 
works for FS linkages with 0-lag, but the linkages can be changed with 
Method (b) above.  

Select tasks and use Ctrl+F2.  

 5.2  Check that all linkages are correct. Ideally, there should be a critical 
path from beginning to end, and all tasks, deliverables and milestones 
are linked.  

 5.3 Save file. 

6 Duration & Dates Enter fixed dates and duration. 

 6.1 Enter any known fixed dates under the Start and Finish columns. 

 6.2 Enter estimated duration (if available) for all detail tasks under the Dur. 
Column. Later, after the formal estimating procedure has been 
completed, they will be adjusted.  

 6.3 Enter duration and dates for fixed duration and fixed time period tasks, 
such as fiscal year maintenance or seasonal field work tasks. Go to 
WINDOW/SPLIT , creating a split window and set "Effort Driven" box to 
"off" and Task Type to "fixed duration" in lower window for these tasks, 
to ensure duration does not change.  

 6.4 Review. 

 6.5 Save file. 

 6.6 Print a trial project plan at this point. Your plan will have all tasks, 
milestones, deliverables, linkages, and first estimates for duration. It will 
have no resources yet.  

7 Resources Enter resources. 

 7.1 Identify all the Resources that will be employed on the project. 

 7.2 Go to VIEW/RESOURCE ENTRY 

 7.3 Enter the names of all project resources in the Resource Name column. 
Where a resource requirement has been identified, but an individual has 
yet to be assigned, enter a meaningful identifier as the resource name 
until an individual is assigned (e.g. tester1, tester2). 
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 Step Action 
 7.4 Complete the Initials column by entering the 1st letter of the resource’s 

1st and last names in capital letters, followed by the 2nd and 3rd letters of 
the last names in small letters (e.g. Jane Doe –"JDoe").  

 7.5 The Organization (Org’n) and Group columns can be used to sort or 
filter resources for reporting purposes. The Group field is used in the 
STATUS REPORT – GROUP view. 

 7.6 The Sort Field column is used to help sort the resources into the desired 
order. Typically, it is filled with surnames. 

8 Assign resources Assign resources 

 8.1 Resources are assigned to the project plan as follows:  

Select WINDOW/SPLIT to split the view and obtain a Task Form in the 
bottom window.  

Click on the Resource Assignment key on the Entry bar (identified by the 
two faces icon). This will bring up a Resource Assignment Box on the 
bottom right of the screen.  

In the top window, highlight the specific task where resources are to be 
assigned.  

In Resource Assignment Box, search for specific resource and highlight 
the name.  

If resource is missing, return to VIEW/RESOURCE ENTRY and add the 
appropriate resource information (name, initials, group, etc.). Return to 
VIEW/ENTRY GANTT and continue to assign resources.  

If you know the unit allocation, enter that number as a percentage. If you 
do not know the allocation yet, then allow the default settings to be 
assigned for the time being. (See next section on Estimating.)  

Assign the resource to the task by clicking on the "Assign" button.  

Observe assignment including units and work in the Task Form.  

Repeat steps d) to h) for each resource assigned to the task.  

You can make corrections and changes by removing the resource 
(using "remove" key in Assignment Box) and re-entering. Alternatively, 
change the values in the Task Form. Note carefully the effect on task 
duration and work effort. You may have to make adjustments.  

Repeat steps c) to j) for each task.  

 8.2 Assign a Sponsor and Project Manager or Leader with zero (0) 
allocation and zero (0) work to the main project task. The purpose is to 
show on rollups and management reports.  

 8.3 If applicable, assign specific summary task leaders with zero allocations, 
as above.  

 8.4 Review project plan. 

 8.5 Save file. 

9 Work Effort Enter work effort. Balance the Project Workplan and the Project 
Work Estimates so that the results of both are reasonable and 
accurate. 

 9.1 Using the results of an estimation analysis tool, enter work effort and 
unit allocations for every resource-driven task in the project plan, 
following the steps described in the "Enter Resources" step above. 
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 Step Action 
 9.2 Check duration as each resource work effort is entered. 

 9.3 Check Plan carefully for reasonableness and accuracy. 

 9.4 Save file. 

10 Resource 
Leveling 

Level resources. It is important that resources not be over-
allocated, i.e., over 100% allocated to work effort in a period of 
time.  

 10.1 Go to VIEW/RESOURCE % ALLOCATION (Percent Allocation by 
Month) and select this view.  

 10.2 Check each resource for over-allocations (over 100%) or under-
allocations.  

 10.3 If there is a plan entry error, correct.  

 10.4 Otherwise, review plan with project manager, leader and/or team and 
make adjustments to the plan. 

 10.5 (Optional). You may select TOOLS/RESOURCE LEVELING and allow 
MS Project to level the plan so that resources are not over-allocated. 
However, this can be dangerous and result in tasks not being 
scheduled when you’d like them to be. It is better practice to 
manually level the project. 

11 Notes Enter notes. You may add notes to milestones or deliverables. They 
will appear to the left of the symbol on the Gantt Chart.  

 11.1 Select milestone or deliverable task number. 

 11.2 Go to INSERT/TASK NOTES … or Select "Attach Note" Icon on the 
Task Bar. 

 11.3 Enter Note information. Keep it brief. 

 11.4 Click OK. 

 11.5 Save file. 

12 Reporting Print draft workplan reports. Reports are needed for review, before 
final Plan Approval and Baseline setting. 

 12.1 Decide which Views and Reports are necessary for your Plan. 

 12.2 For Views:  

Select VIEW/(selected view)  

Enter any information that may be required to generate the report.  

Select FILE/PRINT.  

Make sure you have the correct Printer.  

For any reports with a Gantt, select dates ranging from 2-3 months prior 
to project start to up to 6 months after project finish.  

Perform a Preview to see what the report will look like:  

- Does it fit nicely on the page?  

- Is it trying to go over two pages to the right (horizontally)?  

If the Gantt is not fitting well, try some or all of the following:  

- In PRINT SETUP, adjust Scaling.  

- Go to FORMAT/TIMESCALE and adjust timescale and/or "enlarge" 
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 Step Action 
entry.  

- Reduce Table columns printed in FILE/PRINT SETUP/ "View" tab 
entry.  

- Change margins.  

Note that if you change the "enlarge" value in the Timescale to other 
than 100%, you must also turn off the "Fit Timescale to Page" option in 
Page Setup for the scaling to work.  

- Select FILE/PAGE SETUP and click on the View tab.  

- Deselect the "Fit Timescale to Page" option. Click OK.  

If print preview looks good, Print the report from the View. Before doing 
so, check page count and print only the pages you want.  

 12.3 For Reports:  

Select VIEW/REPORTS … /CUSTOM.  

Review list of reports and select.  

Print Preview to see what it looks like.  

Answer any selection questions that may be asked. (The same question 
may repeat twice because MS Project has two passes.)  

Edit if necessary.  

Select "Print" and select months to be printed (if appropriate). One fiscal 
year usually fits well on one horizontal page.  

Print Preview from Print if necessary. Use Scaling as necessary.  

If print preview looks good, print the report. Before doing so, check page 
count and print only the pages you want.  

 12.4 Some special hints for reporting:  

Page Breaks are created at any point in the plan from INSERT/PAGE 
BREAK.  

Delete a Page Break by selecting the task below it, and going to 
INSERT/DELETE PAGE BREAK.  

Page Breaks are often needed for detail reports but not for Summaries. 
If your plan has page breaks, then do the following:  

- Print all detail reports and Gantts first.  

- Select all tasks (select top left box in title area).  

- Go to INSERT/REMOVE ALL PAGE BREAKS and Select.  

- Then print all summary reports.  

- Make sure you don’t save the file now (you’ll lose all the page breaks!).  

For using the Plotter, refer to the PSO for assistance.  

13 Baseline Set baseline plan. Once the workplan has been approved, and 
(preferably) before any progress has been recorded, a Baseline 
should be set. 

 13.1 Go to TOOLS /TRACKING/SAVE BASELINE 

 13.2 Click OK. 

14 Project Binder File plan reports. 
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 Step Action 
 14.1 File all project plans in Project Binder. 

15 Tracking Enter project progress information. 

 15.1 For generating status reports, go to VIEW/STATUS REPORT. When the 
"Current Tasks" box appears with the question "Tasks Started by (Date)" 
enter a date which you wish future tasks to appear on the report. The 
report will include all tasks with a % complete greater than 0 and less 
than 100, plus all tasks at 0% whose start date is less than or equal to 
the entered date. Pick a date about two-four weeks ahead, to show all 
current tasks and tasks due to start soon.  

 15.2 Print a status report for every project, every week (or according to the 
reporting cycle) and deliver to the project leaders, asking them to update 
progress. 

 15.3 Upon return of the status report, use either the STATUS REPORT, 
TASKS SHEET OR ENTRY-GANTT-TRACKING to record progress. 
Record comments as appropriate in the STATUS REPORT so they will 
appear on the next report (not used anywhere else).  

 15.4 For every detail task where progress is to be recorded, enter a value in 
the "% Comp" Column. Do not enter anything in Summary Tasks. 
Except for fixed duration tasks such as Maintenance or Administrative 
tasks, use the Standards for percent completions, which are listed in the 
Legend at the bottom left of the Gantt charts. For fixed duration tasks 
where the guidelines make no sense, estimate a reasonable number 
that best represents reality. Normal procedure is to judge the length of 
the task bar versus the current date gridline and insert the value that 
most closely matches the gridline (so that the task doesn’t show as 
either "early" or "late". 

 15.5 For completed Milestones and Deliverables, enter "100%". 

 15.6 Check all tasks where there has been a duration or date change and fix 
any incorrect % complete entries. 

 15.7 Review project plan carefully. Note how progress has translated in the 
summary tasks. 

 15.8 Save file. 

 15.9 Print various status and summaries reports, according to the needs of 
the project management team. They may include: Status Reports, 
Summary Gantts, Milestones, or Major Milestones, Milestone Variance 
Report, Gantt Charts and Resource Reports. 
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